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AN87391 では PSoC® 4 に内蔵された LCD ドライバーを使用してセグメント LCD を容易に駆動する方法を紹介します。PSoC 

4 は複数の LCD 駆動モード、低消費電力性を持ち、ユーザー インターフェースとシステム ソリューションを提供します。 

本アプリケーション ノートでは、サンプル プロジェクトにより、低消費電力 LCD の設計、および CapSense®を含むユーザー 

インターフェース ソリューションを説明します。 
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1 はじめに 

血糖値計、マルチメータや血圧計などほとんどの低消費電力ポータブル ハンドヘルド デバイスは、セグメント LCD を使って

情報を表示します。セグメント LCD はマイクロコントローラーとインターフェースするために外部ドライバーを必要とします。

PSoC 4はセグメント LCDを直接駆動できる低消費電力 LCD ドライバーを実装しています。 

PSoC 4は単一のチップに、コンフィギュレーション可能なアナログとデジタル ペリフェラル機能、静電容量式タッチ センシング、

メモリおよび 32ビット Arm® Cortex®-M0マイクロコントローラーを内蔵しているプログラマブル組み込みシステムオンチップで

す。PSoC 4 は市場投入までの時間を加速し、重要なシステム機能を統合し、システム全体のコストを削減します。PSoC 4

の静電容量タッチ センシング機能 (CapSense) は LCD 駆動と共に、1 個の PSoC 4 だけでユーザー インターフェ－ス 

ソリューションの実装が可能です。PSoC 4 には消費電力を低減するフレキシブルな低消費電力モードがあります。例えば、

PSoC がディープスリープ低消費電力モードである場合、セグメント LCD の消費電流は 3.1μA もの低さになります。PSoC 

Creator™ IDEは、異なるタイプのセグメント LCDモジュールを PSoC 4と共に使いやすくするセグメント LCDコンポーネント

を提供します。 

本アプリケーション ノートはサンプル プロジェクトによって、PSoC 4 のセグメント LCD 駆動によってもたらされる特長に 

ついて説明し、低消費電力 LCD 設計のベスト プラクティスや、サンプル プロジェクトを使用してユーザー インターフェース 

ソリューションを示します。 

PSoC 4 を初めてご使用になる場合は AN79953 - Getting Started with PSoC® 4 を参照してください。PSoC Creator の 

ガイドは PSoC Creator のホームページを参照してください。PSoC 4 の電力モードのガイドは AN86233 – PSoC 4 Low-

Power Modes and Power Reduction Techniquesを参照してください。 

2 PSoC リソース 

サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーがデザインに適切な PSoC デバイスを選択し、

デバイスをデザインに迅速で効果的に統合する手助けをしています。リソースの包括的なリストについては KBA86521 – 

How to Design with PSoC 3, PSoC 4, and PSoC 5LP を参照してください。以下は PSoC 4 のリソース要約です。

▪ 概要: PSoCポートフォリオ、PSoCロードマップ 

▪ 製品セレクタ : PSoC 1、PSoC 3、PSoC 4 

または PSoC 5LP。さらに、PSoC Creatorには

デバイス選択ツールが含まれています。 

▪ データシートは PSoC 4デバイス ファミリの電気

的仕様を説明します。 

▪ CapSenseデザイン ガイド: PSoC 4ファミリの

デバイスを使用して静電容量タッチセンシング 

アプリケーションを設計する方法について説明 

します。 

▪ アプリケーション ノートおよびサンプル コードは

基本的なレベルから高度なレベルまでの幅広い

トピックに触れています。多くのアプリケーション 

ノートはサンプル  コードを含みます。PSoC 

Creator はより多くのサンプル コードを提供しま

す。詳細は「サンプル コード」を参照してください。 

▪ テクニカル リファレンス  マニュアル (TRM): 各 PSoC 4

デバイス ファミリのアーキテクチャとレジスタの詳細な説

明を掲載します。 

▪ 開発キット: 

▪ CY8CKIT-040 、 CY8CKIT-042 、 CY8CKIT-044 、

CY8CKIT-046およびPSoC 4 Pioneer Kitsは使いや

すく、安価な開発プラットフォームです。これらのキット

に は Arduino™ 準 拠 シ ー ル ド お よ び Digilent® 

Pmod™ドーター カード用コネクタを搭載します。 

▪ CY8CKIT-049およびCY8CKIT-043はPSoC 4デバイ

スをサンプリングするための低コスト  プロトタイプ 

プラットフォームです。 

▪ CY8CKIT-001はすべてのPSoCファミリ デバイスの

共通開発プラットフォームです。 

▪ MiniProg3 デバイスはフラッシュのプログラムとデバッグ

用のインターフェースをご提供します。 
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2.1 PSoC Creator 

PSoC Creatorは無料の Windowsベースの統合開発環境 (IDE) です。このキットにより、PSoC 3、PSoC 4および PSoC 

5LPベースのシステムについて、ハードウェアとファームウェアの同時並行の設計が可能です。 

図 1に示すように、PSoC Creatorにより以下のことが可能です。 

1. コンポーネントをドラッグ アンド ドロップして、 

メイン デザイン ワークスペースでハードウェア 

システム デザインを構築します。 

2. PSoC ハードウェアとアプリケーション ファーム

ウェアを同時に設計します。 

3. コンフィギュレーション ツールを用いてコンポーネントを 

構成します。 

4. 100以上のコンポーネントを含むライブラリを利用します。 

5. コンポーネント データシートを閲覧します。 

 

図 1. PSoC Creatorの特長 

 

http://www.cypress.com/
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2.2 サンプル コード 

PSoC Creator は多数のサンプル  コードのプロジェクトを含んで 

います。これらのプロジェクトは図 2 に示すように、PSoC Creator の

スタート ページからアクセスできます。 

サンプル プロジェクトにより、空のページではなく出来上がった設計を

元に始めるため、設計時間を短縮することができます。サンプル 

プロジェクトは PSoC Creator コンポーネントを様々なアプリケー 

ションに使用する方法も示します。図 3 が示すように、サンプル コー

ドおよびデータ シートが含まれています。 

図 3 に示す「Find Example Project」ダイアログには、いくつかの 

オプションがあります。 

▪ アーキテクチャまたはデバイス ファミリ (PSoC 3、PSoC 4、

PSoC 5LP) またはカテゴリやキーワードに基づいてサンプル 

プロジェクトをフィルタします。 

▪ Filter Options に基づいて絞り込まれたサンプル プロジェクトの

メニューから選択します。 

▪ Documentation タブで、選択したプロジェクトのデータシートを 

確認します。 

▪ 選択したサンプル コードを確認します。このウィンドウからコード

をコピーし、プロジェクトに貼り付けてコード開発時間を短縮 

できます。または、 

▪ 選択したものをベースに新規プロジェクト (また必要な場合は 

新規ワークスペース) を作成できます。出来上がった基本的な 

設計を元に始めることで設計時間を短縮します。サンプル設計を

所望のアプリケーションに変えて行きます。 

図 2. PSoC Creatorサンプル コード 

 

図 3. サンプル コードを含むサンプル プロジェクト 

 

http://www.cypress.com/
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2.3 PSoC Creatorヘルプ 

PSoC Creator ホームページへアクセスし、PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を 

起動して以下のアイテムを使用してください。 

▪ クイック スタート ガイド: Help > Documentation > Quick Start Guideを選択します。このガイドは PSoC Creator 

プロジェクトを開発するための基礎を提供します。 

▪ 簡単なコンポーネントサンプル プロジェクト: File > Open > Example projects を選択します。これらのサンプル 

プロジェクトは、PSoC Creatorのコンポーネントの設定と使用方法を説明します。 

▪ Starter designs (初級者向けの設計): File > New > Project > PSoC 4 Starter Designsを選択します。これらの 

初級者向けの設計は、PSoC 4のユニークな機能を説明します。 

▪ システム リファレンス ガイド: Help > System Reference > System Reference Guideを選択します。このガイドは

PSoC Creatorにより提供されるシステム機能を一覧で説明します。 

▪ コンポーネント データシート: コンポーネントを右クリックして「Open Datasheet」を選択します。全ての PSoC 4コンポー

ネント データシートの一覧を表示するには、PSoC 4のコンポーネント データシートページへアクセスしてください。 

▪ ドキュメント マネージャー: PSoC Creator が提供するドキュメント マネージャーにより、ドキュメント リソースを容易に 

検索し、閲覧することができます。ドキュメント マネージャーを開くには、メニューから Help > Document Manager を 

選択します。 

2.4 テクニカル サポート 

ご質問には弊社のテクニカル サポート チームが対応させて頂きますので、お気軽にご連絡ください。Cypress Technical 

Supportページにアクセスし、サポート リクエストを作成してください。 

米国のお客様はテクニカル サポート チームに連絡する際、以下の電話番号 (通話無料) にお問い合わせください: +1-800-

541-4736 プロンプトでオプション「8」をご選択ください。 

緊急サポートが必要な場合は、以下のサポート リソースをご利用ください。 

▪ セルフヘルプ 

▪ お近くの販売代理店 
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3 PSoC 4のセグメント LCD駆動の特長 

PSoC 4のセグメント LCD駆動は以下の特長があります。 

▪ 最大 8コモン (COM) と 56セグメント (SEG) 電極をサポート 

▪ PSoC 4のプログラマブル GPIOにより、COMと SEGの電極のフレキシブルな選択が可能 

▪ 14 セグメントと 16 セグメント構成のキャラクタ型ディスプレイ、7 セグメント構成のディスプレイ、ドット マトリクスおよび 

特殊記号をサポート 

▪ 2つの駆動モード: デジタル相関および PWM 

▪ PSoC 4のアクティブ、スリープ、ディープスリープの消費電力モードで動作 

▪ 1.8ボルトの VDDから 3ボルトのディスプレイを駆動することが可能 

▪ デジタル コントラスト制御 

注意: サポートされるコモンとセグメントの数はデバイス ファミリとデバイス パッケージによって異なります。詳細はそれぞれの

デバイスのデータシートを参照してください。 

4 セグメント LCDの基本 

セグメント LCD パネルは 2 セットの電極の間に液晶材料があります。個々の LCD セグメントの上部と下部の電極は、 

それぞれコモン (COM) とセグメント (SEG) 電極と呼びます。図 4に示すように、これらの電極はマトリックスを形成します。 

図 4. COMと SEGの電極 
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図 4のコンデンサは、LCDセグメントの等価静電容量を表します。各対の COM と SEG電極は 1つの LCD セグメントのみ

で接続されています。COM-SEG 電極対の両端にかかる二乗平均平方根 (RMS) 電圧は、対応する LCD セグメントの 

透明度を制御します。 

http://www.cypress.com/
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液晶材料は DC電圧に長時間耐えられません。したがって、COMおよび SEG電極間に印加される波形はそれぞれの LCD

セグメントで DC コンポーネントを 0V とする必要があります。駆動波形は複数の LCD セグメントを同時に有効にするための

時分割多重化を含んでいます。一般の LCD ドライバーは COM と SEG電極で複数の電圧ステップで AC波形を生成します。

以下の用語はこれらの波形を定義する際に使用されます。 

▪ デューティ: M個の COM電極を駆動する場合、ドライバーは 1/Mデューティで動作すると言われます。各 COM電極は

実効的に 1/M 時間駆動されます。PSoC 4100 および PSoC 4200 デバイスは 1/2、1/3 および 1/4 のデューティを 

サポートします。PSoC 4100M、4200M、4100L および 4200L デバイスは 1/2、1/3、1/4 および 1/8 のデューティを 

サポートします。 

▪ バイアス: ドライバーの波形が ((1/B) × VDRV) の電圧ステップを使用する場合、ドライバーは 1/Bバイアスを使用すると

言われます。VDRVはシステムで最も高い駆動電圧 (PSoC 4での VDDと同じ) です。PSoC 4100および PSoC 4200

デバイスは PWM 駆動モードで 1/2 および 1/3 のバイアスをサポートします。PSoC 4100M、4200M、4100L および

4200L デバイスは PWM 駆動モードで 1/2、1/3、1/4 および 1/5 のデューティをサポートします。詳細については 10 

ページの表 1を参照してください。 

▪ フレーム: フレームはすべてのセグメントを駆動するために必要な時間の長さです。フレームの間に、ドライバーは順序に

従って COM 電極を通じて信号を変化させます。フレーム全体を測定するとき、すべてのセグメントで 0V DC (実効値は

0ではない) です。 

セグメント LCD ピクセルの強度またはコントラストはピクセルに適用する RMS電圧に依存します。図 5に LCD セグメントの

コントラストおよび RMS電圧の関係を示します。 

図 5. RMS電圧とコントラストの関係 

 

図 5の用語は以下のように定義されます。 

▪ VOFF: ピクセルにかかる RMS電圧であり、それ以下でコントラスト変化は LCDに現れません。 

▪ VTHR: 10%コントラストが達成されたピクセルにかかる RMS電圧です。 

▪ VON: 90%コントラストが達成されたピクセルにかかる RMS電圧です。 

▪ VLO: LCD ドライバーが生成できる最低の RMS電圧です。 

▪ VHI: LCD ドライバーが生成できる最高の RMS電圧です。 

▪ 識別比率 (D): ドライバーが実現できる VHIと VLOとの比率です。識別比率が高いとコントラストが良くなります。 

ツイスト ネマチック (TN) とスーパー ツイスト ネマチック (STN) ディスプレイは、セグメント LCDの最も一般的に利用可能な 

タイプです。TN ディスプレイは STN ディスプレイに比べて透明度の顕著な違いを生成するために RMS 電圧の高い変化を 

必要とします。従って、所定の識別比率に対して STN ディスプレイは TN ディスプレイより優れたコントラストを提供します。

STNディスプレイは優れた視野角もあります。しかし、TNディスプレイは一般的に STNディスプレイより安価です。 

セグメント LCDの基本の詳細は PSoC 4テクニカル リファレンス マニュアル (TRM) を参照してください。 
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5 PSoC Creator コンポーネント: セグメント LCD 

PSoC Creator は、異なるタイプのセグメント LCD モジュールと PSoC 4 をインターフェースしやすくするセグメント LCD 

コンポーネントを提供します。コンポーネントを PSoC Creatorのプロジェクト回路図にドラッグ＆ドロップして LCDモジュール

を設定します。また、コンポーネントは使いやすいアプリケーション プログラミング インターフェース (API) を提供します。 

詳細は PSoC 4 セグメント LCDコンポーネント データシートを参照してください。 

また、プロジェクト「セグメント LCD の基本」も参照してください。このプロジェクトはセグメント LCD コンポーネントおよび API

を使用して PSoC 4と 7セグメント構成の 4桁 LCDモジュールをインターフェースする方法を示します。 

6 PSoC 4 セグメント LCDの直接駆動 

PSoC 4は PWMおよびデジタル相関という 2つのセグメント LCD駆動モードをサポートします。それらは LCDに必要な AC

波形を生成するために異なる技術を使用し、異なるコントラストおよび消費電力特性を持ちます。次の節は 2 つの駆動モード

の違いについて詳細に説明します。 

6.1 PWM駆動モード 

PWM 駆動モードは高周波  (32kHz～48MHz) の PWM デジタル信号を使用して、LCD セグメントにかかる低周波 

(30～150Hz) のアナログ駆動波形を生成します。図 6 に示すとおり、LCD セグメントの静電容量およびパネル抵抗は、LCD

セグメントに与える電圧を生成するために、高周波の PWM信号をフィルタします。 

図 6. PWM駆動モード 
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6.2 デジタル相関駆動モード 

デジタル相関駆動モードは、低消費電力でバッテリ駆動アプリケーションに最適な特許出願中のサイプレスの発明です。 

非アクティブ フレーム間隔で COM信号の駆動周波数を 2倍にすることにより動作します。これはセグメントにかかる VRMSを

変更して、その結果、セグメントのコントラストに影響を与えます (図 5を参照してください)。図 7にデジタル相関モード波形の

例を示します。 

図 7．デジタル相関モード波形の例 
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各駆動モードとそれに対応する波形の詳しい説明は PSoC 4テクニカル リファレンス マニュアルを参照してください。 
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セグメント LCD は RC 直列回路の特性を持ちます。したがって、消費電力は動作周波数に依存します。デジタル相関駆動 

モードは、動作周波数が非常に低いため、PWM駆動モードよりかなり少ない消費電流です。 

しかし、PWM モードのコントラストと視野角は、デジタル相関モードよりも優れています。これは PWM モードが高い識別比率 

(図 5) を持つためです。表 1に識別比率の比較を示します。 

表 1. 識別比率の比較 

COM 

識別比率 

デジタル相関 
PWM 1/2 

バイアス 

PWM 1/3 

バイアス 

PWM 1/4 

バイアス 

PWM 1/5 

バイアス 

2 1.732 2.236 2.236 1.844 1.612 

3 1.414 1.732 1.915 1.732 1.567 

4 1.291 1.528 1.732 1.648 1.528 

8 1.134 1.254 1.414 1.581 1.494 

これらの駆動モード間のコントラストと視野角の実際の差は、LCDモジュールの特性に依存します。 

6.3 低消費電力動作 

PSoC 4 セグメント LCD ドライバを使用するとき、消費電力を削減するために以下の手順に従ってください。 

1. AN86233 - PSoC 4 Low-Power Modes and Power Reduction Techniquesを参照してください。この文書で説明した

手法を実装してシステム全体の消費電力を削減してください。 

2. 可能な限りディープスリープ モードに移行してください。ディープスリープモードは、セグメント LCD の駆動能力を保持 

した PSoC 4で最も低い消費電力モードです。  

3. デバイスはディープスリープ モードのとき、セグメント LCDのデジタル相関駆動モードを使用してください。  

PWM 駆動モードに比べて、デジタル相関モードは TN ディスプレイに対して少しコントラストと視野角が低くなり、STN 

ディスプレイに対してはコントラストまたは視野角に大差はありません。しかしデジタル相関モードは PWM モードより電流の

消費が非常に少なくなります。表 2 は 2 つの駆動モードの電流消費量を比較し、表 3 は駆動モードの推奨使用方法を 

示します。  

注: 表 2は PSoC 4200デバイスで 3 COM、12 SEG LCDのおおよその消費電流を示します。実際の消費電力はデバイス 

ファミリ、使用された LCDのタイプおよびファームウェアに依存します。 

表 2. セグメント LCDが有効なときのディープスリープ モードでの標準的なデバイス消費電流  

フレーム レート 

(Hz) 

消費電流 (µA) 

デジタル相関モード PWMモード 

30 3.1 65.9 

50 3.8 66.2 

70 4.5 66.5 

90 5.1 66.7 

110 5.8 67.1 

130 6.5 67.3 

150 7.4 67.6 
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表 3. 低消費電力動作を考慮した駆動モードの推奨使用方法 

ディスプレイタイプ 

ディープスリープ 

モード 

アクティブおよび 

スリープ モード 備考 

TN LCD デジタル相関 PWM ファームウェアは動的に LCD駆動モードを切り替える必要があります。 

STN LCD デジタル相関 

STN LCDを使用するとき、PWM ドライブはコントラストに関して利点が 

ありません。 

消費電力とディスプレイのコントラストとの間で最適なバランスを得るために実行中に LCD 駆動モードを変更することが 

できます。図 8 にアクティブ モードでの良好なコントラストと視野角、およびディープスリープ モードでの消費電力の低減の 

ために LCD駆動モードを動的に切り替えるファームウェアの流れを示します。 

詳細は「低消費電力セグメント LCD」プロジェクトを参照してください。 

図 8. 低消費電力 LCD動作のファームウェアの流れ 

Active mode: Run LCD in PWM mode to get 

better contrast and viewing angle

Go to Digital Correlation drive mode before 

going to Deep-Sleep mode

Call the Deep-Sleep API

Go back to PWM mode when the processor 

goes back to active mode
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7 PSoC 4ユーザー インターフェース ソリューション 

このセクションでは PSoC 4のみを使用してユーザー インターフェース (UI) ソリューションを作成する方法について説明しま

す。このセクションの内容を理解するために、PSoC 4 CapSenseの基本的な知識を身に付ける必要があります。CapSense

の基本を理解するために PSoC 4 CapSense設計ガイドを参照してください。 

PSoC 4 の CapSense 機能はかつてない信号対雑音比 (SNR)、クラス最高の耐水性および多種多様なセンサー (ボタン、 

スライダー、トラックパッドや近接センサーなど) を提供します。優雅で、信頼性が高く、電力効率が良く、使いやすい UI 

ソリューションを作成するために、CapSenseと低消費電力モードと共にセグメント LCD駆動を使用することができます。 

図 9 に PSoC がセグメント LCD を駆動し、タッチパネルをスキャンする UI サンプルを示します。タッチパネルは 2 つの

CapSenseボタンとスライダーで構成されています。 

図 9. PSoC 4ユーザー インターフェースの例 

PSoC 4

CapSense

Button
CapSense Slider

CapSense

Button

Touch Panel

Segment LCD

 

CapSense はディープスリープ モードでセンサーをスキャンすることはできないため、デバイスは周期的に復帰してセンサー

をスキャンする必要があります。センサーのスキャン中、PSoC 4はアクティブ モードでなければなりません。消費電力を節約

するために、ディープスリープ モードの時間を長く、アクティブ モードの時間を短く動作させる必要があります。 

CapSenseがタッチを検出すると PSoC 4はアクティブ モードのままとなり、タッチ パネル入力を読み出すために各センサー

を個別にスキャンします。パネルが再び非アクティブになると、デバイスはディープスリープ モードに戻ります。 

PSoC 4 CapSense は複数のセンサーを 1 つにまとめて、単一のセンサーとしてスキャンすることができます。これは 

アクティブ モードの総時間を削減します。 

http://www.cypress.com/
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図 10に低消費電力のユーザー インターフェース (UI) ソリューションのサンプル ファームウェアの流れを示します。 

図 10. 低消費電力 UIソリューションのファームウェアの流れ 

Check if the touch panel is 
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Scan all CapSense sensors individually.

Change LCD drive mode to PWM
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詳細は「セグメント LCD および CapSense ユーザー インターフェース」プロジェクトを参照してください。このプロジェクトは 

7セグメント構成の 4桁 LCDおよび 5素子 CapSenseスライダーのユーザー インターフェースを示します。 
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8 PSoC Creatorプロジェクト 

このアプリケーション ノートでは 4つのサンプル プロジェクトを紹介します。 

1. セグメント LCD の基本: これは PSoC Creator PSoC 4 セグメント LCD コンポーネントの基本的な使用法を説明する 

ためのシンプルなプロジェクトです。 

2. 低消費電力セグメント LCD: このプロジェクトは消費電力を極めて低く抑えてセグメント LCD コンポーネントを使用する 

方法を示します。 

3. セグメント LCD と CapSense ユーザー インターフェース: このプロジェクトはセグメント LCD と CapSense コンポー 

ネントを使用するユーザー インターフェース ソリューションの作成方法を示します。 

プロジェクト 1 と 2 を評価するために、PSoC 4 キットあるいはお持ちのハードウェアを使用できます。プロジェクト 3 は 

サイプレス CY8CKIT-042が必要です。 

3 つのプロジェクトは、3 つの COM 電極と 12 の SEG 電極がある 7 セグメント構成 4 桁の VIM 404 セグメント LCD 

モジュールが必要です。詳しい回路図は、19ページの図 17を参照してください。 

4. キャラクタ型セグメント LCD: このプロジェクトは PSoC 4100M／4200M デバイスで使用可能な多数の GPIO を利用 

して、4つの COM電極および 32の SEG電極がある 14セグメント構成 8桁の VIM-828セグメント LCDモジュールを

駆動します。このプロジェクトはサイプレスの CY8CKIT-043 または CY8CKIT-046 と VIM-828 セグメント LCD 

モジュールが必要です。 

8.1 プロジェクト 1: セグメント LCDの基本 

このプロジェクトを作成するために、以下のようにしてください。 

1. 新しい PSoC 4プロジェクトを作成します。PSoC Creatorを初めてご使用になる場合は PSoC Creatorのホームページ

を参照してください。 

2. セグメント LCD コンポーネントとクロック コンポーネントを TopDesign回路図にドラッグ アンド ドロップします。図 11に

示すように、それらを一緒にワイヤーで接続します。 

図 11. LCDとクロックの接続 

 

3. セグメント LCDコンポーネントをダブルクリックし、設定ウィンドウを開きます。 
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4. コンポーネント コンフィギュレーション ダイアログで、General タブを設定します。図 12 に示すように、LCD 駆動設定を

選択します。 

図 12. セグメント LCDコンフィギュレーションの「General」タブ 

 

▪ VIM 404 セグメント LCD モジュールに合わせるために、コモンとセグメントのライン数をそれぞれ 3 と 12 にセット 

します。 

▪ PWM 駆動モードを使用します。8 ページの REF _Ref367351882 \h  \* MERGEFORMAT PSoC 4 セグメント

LCDの直接駆動を参照してください。 

▪ VIM 404セグメント LCDモジュールで良いコントラストを得るため、1/2バイアスを選択します。 

▪ Type B 波形を選択します。Type B 波形は Type A 波形より消費電力がわずかに少なくなります。これらの波形の

詳細については、PSoC 4テクニカル リファレンス マニュアルを参照してください。 

▪ 残りの設定はそれぞれ初期値のままにします。 
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5. Display Helpers タブを設定します。このタブは SEG および COM 電極をディスプレイ モジュールにマッピングします。

このタブを設定するために、LCDモジュールのデータシートを使用します (VIM-404を参照してください)。 

この LCDモジュールは 7セグメント構成で 4桁あります。7セグメント ディスプレイ ヘルパーを追加するために Helpers

リストボックス内で 7 Segment を選択し、 ボタンをクリックします。図 13 に示すように、選択したディスプレイ 

機能が Selected helpers リスト ボックスに表示されます。 

図 13. ディスプレイ ヘルパーの追加 

 

LCDモジュールは 7セグメント構成の 4桁です。 ボタンをクリックしてあと 3桁を追加します。 
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6. 図 14 に示すように、該当する桁からセグメントをドラッグし、ピクセル マッピング テーブルにドロップします。VIM 404 

LCDモジュールのピクセル マッピングについては、VIM-404データシートを参照してください。 

図 14. ピクセル マッピングの手順 
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7. ディスプレイの各セグメントに対し、同じプロセスを繰り返します。全てのピクセルをマッピングすると、テーブルは図 15の

ように完成します。 

図 15. 完成したピクセル マッピング テーブル 
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8. OK をクリックします。これでセグメント LCD コンポーネントの設定は完了します。図 16 に示すように、コモンとセグメント

にピンを割り当てるために、.cydwr (デザインワイド リソース) ファイルを開き、ピンを割り当てます。 

注: ここに示すピン割り当ては CY8CKIT-042 開発キット用です。異なるキットをご使用になる場合、キット ユーザー 

ガイドを参照して、キットのいずれかの周辺機器に接続されない適切なピンを選択してください。  

図 16．ピン割り当て 

 

9. 図 17 に示すように、VIM 404 LCD を PSoC 4 に配線します。これは個別の PCB または CY8CKIT-042 キットおよび

Arduino ProtoShield基板で行えます。 

図 17. PSoC 4から LCDモジュールへの外部接続 

1      2      3      4      5      6      7      8      9      10

20    19    18    17    16    15    14    13    12    11

PSoC 4 

Vdd

Vss

3.3V

V
IM

 4
0

4

P0[5]
P0[7]

P2[4]
P0[4]

P1[0]
P3[5]

P2[6]
P2[7]

P3[4]
P2[3]

P3[1]
P3[0]

P3[7]

P0[6]
P0[0]

 

 

http://www.cypress.com/
http://www.cypress.com/?rID=77780


  PSoC® 4 セグメント LCDの直接駆動 

www.cypress.com 文書番号: 002-11594 Rev. *A 20 

10. ファームウェアをプロジェクトに追加します。1、2、3、...9、0 の数字がスクロールする表示をさせるために、コード 1 の 

コードをmain.cに追加します。 

セグメント LCD コンポーネントはすぐに使える API を提供します。API関数の詳細は PSoC 4 セグメント LCD コンポー

ネント データシートを参照してください。 

コード 1. LCDで数字のスクロール 

#include <device.h> 

 

/* Macro for a black space on the 7-segment LCD */ 

#define  BLANK  (16u) 

 

/* Macro for scrolling length */ 

#define  SCROLL_LENGTH  (14u) 

 

/* Macro for initial scrolling value */ 

#define  INITIAL_VALUE  (0u) 

 

/* Define the numbers used for scrolling the 4-digit display */ 

#define  SCROLL0  (0u) 

#define  SCROLL1  (1u) 

#define  SCROLL2  (2u) 

#define  SCROLL3  (3u) 

#define  DIGIT0   (0u) 

#define  DIGIT1   (1u) 

#define  DIGIT2   (2u) 

#define  DIGIT3   (3u) 

 

/* Define the loop delay */ 

#define  LOOP_DELAY  (512u) 

 

void main() 

{ 

    /* This variable is used to index the character array */ 

    uint8 index = 0; 

 

    /* Array of scrolling numbers including blank spaces to improve visibility */ 

    uint8 numbers[] = {BLANK, BLANK, BLANK, BLANK,  

                       1, 2, 3, 4, 5, 6, 7, 8, 9, 0, BLANK, BLANK, BLANK}; 

 

    /* Starts the Segment LCD Component */ 

    LCD_Start(); 

 

    for(;;) /* do forever */ 

    { 

        /* Scroll the blanks and numbers stored in the array, from right to left */ 

        for(index = INITIAL_VALUE; index < SCROLL_LENGTH; index++) 

        { 

            /* Print the numbers on the LCD glass */ 

            LCD_Write7SegDigit_0(numbers[index + SCROLL3], DIGIT0); 

            LCD_Write7SegDigit_0(numbers[index + SCROLL2], DIGIT1); 

            LCD_Write7SegDigit_0(numbers[index + SCROLL1], DIGIT2); 

            LCD_Write7SegDigit_0(numbers[index + SCROLL0], DIGIT3); 

 

            /* Give delay for a visible scrolling */ 

            CyDelay(LOOP_DELAY); 

        } 

    } 

} 

11. PSoC 4 が 3.3V VDD 電源で動作していることを確認してください。デバイスをプログラムし、LCD ディスプレイを表示して 

出力を検証します。図 18に示すように、右から左へ 1、2、3、...、9、0の数字がスクロールします。 

http://www.cypress.com/
http://www.cypress.com/?docID=43135&source=an87391
http://www.cypress.com/?docID=43135&source=an87391


  PSoC® 4 セグメント LCDの直接駆動 

www.cypress.com 文書番号: 002-11594 Rev. *A 21 

図 18. LCDディスプレイ モジュール 数字のスクロール 

 

ディスプレイのコントラストが高すぎる場合、セグメント LCD コンポーネントのコントラストを減らし、デバイスを再度プログラム

します。 

8.2 プロジェクト 2: 低消費電力セグメント LCD 

このプロジェクトは平均消費電力を低減するためにプロジェクト 1を変更したものです。 

消費電力を低減するために、PSoC 4 が表示を更新し、数字を 1 桁スクロールする時間だけアクティブ モードにします。 

これには約 720µs かかります。その後デバイスは、512ms 間のディープスリープ消費電力モードに遷移します。図 19 に 

タイミング図を示し、図 20にファームウェアの流れを示します。 

この手法では、PSoC 4 は 11µA 未満の平均電流を消費します。表 4 に 2 つのプロジェクトの消費電流の概算値の比較を 

示します。 

表 4. 消費電流の比較 

電力モード プロジェクト 1 本プロジェクト 

アクティブ電流 2.7mA 2.7mA 

ディープスリープ電流 なし 7µA 

平均電流 2.7mA 10.9µA 

 

図 19. プロジェクト 2のタイミング図 
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図 20. プロジェクト 2のファームウェアの流れ 

Change LCD drive mode to Digital 
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このプロジェクトはウォッチドッグ タイマー (WDT) 割り込みを生成するためにグローバル信号コンポーネントを使用します。 

図 21 に示すように、コンポーネントを設定します。WDT は 512ms ごとに割り込みを生成するように設定されます。図 22 に 

このプロジェクトの TopDesign回路図を示します。 

図 21. グローバル信号コンポーネントの設定 
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図 22. プロジェクト 2の LCD TopDesign回路図 

 

プロジェクトをテストするために、デバイスをプログラムし、プロジェクト 1 (図 17) のようにディスプレイを接続し、出力を 

確認します。数字のスクロール表示は同じですが、このプロジェクトの消費電力はかなり削減されます。 
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8.3 プロジェクト 3: セグメント LCDおよび CapSenseユーザー インターフェース 

このプロジェクトでは CapSense タッチ センシングと表示用セグメント LCD からなるユーザー インターフェース (UI) を 

紹介します。UI コントローラーはユーザー入力の待ち受けにほとんどの時間を費やします。電力効率のよい実装をするため、

PSoC 4は周期的にディープスリープ低消費電力モードに入ります。 

注: このプロジェクトは非常に短いスキャン時間と低い消費電力を達成するために CapSense ウィジェットの手動チューニン

グを使用します。このプロジェクトを理解するために CapSense の手動チューニングの知識が必要です。手動チューニングの

詳細は PSoC 4 CapSense設計ガイドを参照してください。 

このプロジェクトは CapSense 能力を追加するようにプロジェクト 2 を変更したものです。図 23 にタイミング図を示し、図 24

にこのプロジェクトの TopDesign回路図を示し、図 25にファームウェアの流れを示します。 

このプロジェクトでは、CapSense が高速タッチを検出するよう頻繁にセンサーをスキャンするため、PSoC 4 は 128ms の 

間だけディープスリープ モードに入ります。復帰すると CapSense は全てのスライダー素子を 1 つにまとめ、1 つの近接 

センサーとしてスキャンします。いずれかのスライダー素子がタッチされると、近接センサーはタッチを検出し、その後で各素

子はスライダー タッチ位置を確定するために個別にスキャンされます。スライダー位置はその後、LCD上に表示されます。 

タッチを検出した後で、全ての CapSense ウィジェットが 128ms の間非アクティブである場合、デバイスはディープスリープ 

モードに戻ります。タッチを検出しない場合、PSoC 4の平均消費電流は 21µA以下です。 

図 23. プロジェクト 3のタイミング図 
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図 24. プロジェクト 3の TopDesign回路図 
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図 25. プロジェクト 3のファームウェアの流れ 
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プロジェクトをテストするために図 17 のように LCD を接続し、スライダーをタッチし、LCD が指の位置を表示することを確認 

します。スライダーが非アクティブのとき、LCD はデバイスがディープスリープ モードにあることを示すように「dSLP」を 

表示します。初期値の CapSenseパラメーターを、所与の条件で CY8CKIT-042用に手動で調整することに注意してください。

タッチ応答性が悪い場合、CapSense を手動で再度調整する必要があります。別の方法として、すべてのパラメータを最適な

値に自動的に設定するファームウェア アルゴリズムである SmartSense™の使用があります。詳細は PSoC 4 CapSense

設計ガイドを参照してください。SmartSense を使用すると消費電力が増えることに注意してください。このプロジェクトに

SmartSenseを使用すれば、平均消費電力は約 40µAです。 
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8.4 プロジェクト 4: キャラクタ型セグメント LCD 

このプロジェクトは PSoC 4100M／4200M／4100L／4200Lデバイスで使用可能な多数の GPIOを利用して、4つの COM

電極、32の SEG電極がある 14 セグメント構成 8桁の VIM-828 セグメント LCD モジュールを駆動します。このプロジェクト

はサイプレスの CY8CKIT-043または CY8CKIT-046と VIM-828 LCDが必要です。 

セグメント LCD コンポーネントは、14 セグメント構成のキャラクタ型ディスプレイに文字列を表示するために、豊富な API を 

提供します。このプロジェクトは VIM-828 に「PSoC4200」の文字を表示します。詳細は PSoC Creator プロジェクトを 

参照してください。表 5に VIM-828から CY8CKIT-43または CY8CKIT-46への配線情報を示します。 

表 5. 配線情報 

LCDピン番号 LCDピン機能 CY8CKIT-43接続先 CY8CKIT-046接続先 

1 COM3 P0[7] P2[0] 

2 SEG0 P0[6] P2[1] 

3 SEG1 P0[5] P2[2] 

4 SEG2 P0[4] P2[3] 

5 SEG3 P0[3] P2[4] 

6 SEG4 P0[2] P2[5] 

7 SEG5 P0[1] P3[6] 

8 SEG6 P0[0] P3[7] 

9 SEG7 P7[1] P9[0] 

10 SEG8 P4[0] P9[1] 

11 SEG9 P3[7] P9[2] 

12 SEG10 P3[6] P9[3] 

13 SEG11 P3[5] P6[1] 

14 SEG12 P3[4] P6[0] 

15 SEG13 P3[3] P6[3] 

16 SEG14 P3[2] P4[0] 

17 SEG15 P3[1] P4[1] 

18 COM2 P3[0] P3[4] 

19 COM0 P6[5] P6[5] 

20 SEG16 P6[4] P5[5] 

21 SEG17 P6[2] P5[6] 

22 SEG18 P6[1] P4[4] 

23 SEG19 P6[0] P4[5] 

24 SEG20 P2[7] P4[6] 

25 SEG21 P2[6] P4[7] 

26 SEG22 P2[5] P3[1] 

27 SEG23 P2[4] P3[0] 

28 SEG24 P1[3] P8[7] 

29 SEG25 P1[2] P8[6] 

30 SEG26 P1[1] P8[5] 

31 SEG27 P1[0] P8[4] 

http://www.cypress.com/
http://varitronix.com/prod_pdf/VIM-828.pdf
http://www.cypress.com/go/cy8ckit-043
http://www.cypress.com/go/cy8ckit-046
http://varitronix.com/prod_pdf/VIM-828.pdf


  PSoC® 4 セグメント LCDの直接駆動 

www.cypress.com 文書番号: 002-11594 Rev. *A 27 

LCDピン番号 LCDピン機能 CY8CKIT-43接続先 CY8CKIT-046接続先 

32 SEG28 P5[5] P8[3] 

33 SEG29 P5[3] P8[2] 

34 SEG30 P5[2] P8[1] 

35 SEG31 P5[1] P8[0] 

36 COM1 P5[0] P5[6] 

 

9 まとめ 

本アプリケーション ノートは PSoC 4 のセグメント LCD 駆動を説明しました。堅牢な静電容量タッチ センシングとクラス 

最高の低消費電力機能を組み合わせたことにより、PSoC 4 は低消費電力、シングルチップ、ユーザー インターフェースの 

ソリューションに理想的な選択肢です。 

また本アプリケーション ノートは、PSoC 4 セグメント LCD コンポーネントの手ほどき、低消費電力動作の見本、ユーザー 

インターフェースの実装について 4つのサンプル プロジェクトを紹介しました。 

PSoC 4はプログラマブル アナログおよびデジタル、32ビット Arm Cortex-M0マイクロコントローラーやシリアル通信ブロック

などの多くの付加機能を備えています。これらの機能により、PSoC 4 を使用してまとまったシステム ソリューションを 

作成できます。 

著者について 
氏名: Nidhin MS 

役職: シニア アプリケーション エンジニア 

経歴: Nidhinは GEC (ガバメント エンジニアリング カレッジ) - トリチュール(インド) を卒業して、電子通信工学の

学士号を取得しました。技術的関心分野はアナログ信号処理、低消費電力設計、静電容量タッチ 

センシングです。 
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http://www.cypress.com/


  PSoC® 4 セグメント LCDの直接駆動 

www.cypress.com 文書番号: 002-11594 Rev. *A 28 

改訂履歴 

文書名:AN87391 – PSoC® 4 セグメント LCDの直接駆動 

文書番号: 002-11594 

版 ECN 発行日 変更内容 

** 5193409 03/30/2016 これは英語版 001-87391 Rev. *C を翻訳した日本語版 002-11594 Rev. **です。 

*A 6655968 01/16/2020 これは英語版 001-87391 Rev. *E を翻訳した日本語版 002-11594 Rev. *Aです。 

http://www.cypress.com/


  PSoC® 4 セグメント LCDの直接駆動 

www.cypress.com 文書番号: 002-11594 Rev. *A 29 

ワールドワイドな販売と設計サポート 

サイプレスは、事業所、ソリューションセンター、メーカー代理店、および販売代理店の世界的なネットワークを保持しています。お客様

の最寄りのオフィスについては、サイプレスのロケーションページをご覧ください。 

 

製品 

Arm® Cortex® Microcontrollers cypress.com/arm 

車載用 cypress.com/automotive 

クロック&バッファ cypress.com/clocks 

インターフェース cypress.com/interface 

IoT (モノのインターネット) cypress.com/iot 

メモリ cypress.com/memory 

マイクロコントローラ cypress.com/mcu 

PSoC cypress.com/psoc 

電源用 IC cypress.com/pmic 

タッチセンシング cypress.com/touch 

USBコントローラー cypress.com/usb 

ワイヤレス cypress.com/wireless 

 

PSoC®ソリューション 

PSoC 1 | PSoC 3 | PSoC 4 | PSoC 5LP | PSoC 6 MCU 

サイプレス開発者コミュニティ 

コミュニティ | サンプルコード | Projects | ビデオ | ブログ |  

トレーニング | Components 

テクニカル サポート 

cypress.com/support

本書で言及するその他すべての商標または登録商標は、それぞれの所有者に帰属します。 

 

Cypress Semiconductor 

198 Champion Court  

San Jose, CA 95134-1709 

© Cypress Semiconductor Corporation, 2013-2020. 本書面は, Cypress Semiconductor Corporation及び Spansion LLCを含むその子会社 (以下「Cypress」という。) に帰属する財

産である。本書面 (本書面に含まれ又は言及されているあらゆるソフトウェア若しくはファームウェア (以下「本ソフトウェア」という。) を含む) は, アメリカ合衆国及び世界のその他の国にお

ける知的財産法令及び条約に基づき Cypressが所有する。Cypressはこれらの法令及び条約に基づく全ての権利を留保し, 本段落で特に記載されているものを除き, その特許権, 著作

権, 商標権又はその他の知的財産権のライセンスを一切許諾しない。本ソフトウェアにライセンス契約書が伴っておらず, かつ Cypressとの間で別途本ソフトウェアの使用方法を定める書

面による合意がない場合, Cypressは, (1) 本ソフトウェアの著作権に基づき,  (a) ソースコード形式で提供されている本ソフトウェアについて, Cypressハードウェア製品と共に用いるため

にのみ, かつ組織内部でのみ, 本ソフトウェアの修正及び複製を行うこと, 並びに (b) Cypressのハードウェア製品ユニットに用いるためにのみ,  (直接又は再販売者及び販売代理店を介

して間接のいずれかで) 本ソフトウェアをバイナリーコード形式で外部エンドユーザーに配布すること, 並びに (2) 本ソフトウェア (Cypressにより提供され, 修正がなされていないもの) が

抵触する Cypress の特許権のクレームに基づき, Cypress ハードウェア製品と共に用いるためにのみ, 本ソフトウェアの作成, 利用, 配布及び輸入を行うことについての非独占的で譲渡

不能な一身専属的ライセンス (サブライセンスの権利を除く) を付与する。本ソフトウェアのその他の使用, 複製, 修正, 変換又はコンパイルを禁止する。 

適用される法律により許される範囲内で, Cypressは, 本書面又はいかなる本ソフトウェア若しくはこれに伴うハードウェアに関しても, 明示又は黙示をとわず, いかなる保証 (商品性及び

特定の目的への適合性の黙示の保証を含むがこれらに限られない) も行わない。いかなるコンピューティングデバイスも絶対に安全ということはない。従って, Cypress のハードウェアま

たはソフトウェア製品に講じられたセキュリティ対策にもかかわらず, Cypressは, Cypress製品への権限のないアクセスまたは使用といったセキュリティ違反から生じる一切の責任を負わ

ない。加えて, 本書面に記載された製品には, エラッタと呼ばれる設計上の欠陥またはエラーが含まれている可能性があり, 公表された仕様とは異なる動作をする場合がある。適用される

法律により許される範囲内で, Cypressは, 別途通知することなく, 本書面を変更する権利を留保する。Cypressは, 本書面に記載のある, いかなる製品若しくは回路の適用又は使用から

生じる一切の責任を負わない。本書面で提供されたあらゆる情報 (あらゆるサンプルデザイン情報又はプログラムコードを含む) は, 参照目的のためのみに提供されたものである。この情

報で構成するあらゆるアプリケーション及びその結果としてのあらゆる製品の機能性及び安全性を適切に設計, プログラム, かつテストすることは, 本書面のユーザーの責任において行わ

れるものとする。Cypress製品は, 兵器, 兵器システム, 原子力施設, 生命維持装置若しくは生命維持システム, 蘇生用の設備及び外科的移植を含むその他の医療機器若しくは医療シス

テム, 汚染管理若しくは有害物質管理の運用のために設計され若しくは意図されたシステムの重要な構成部分としての使用, 又は装置若しくはシステムの不具合が人身傷害, 死亡若しく

は物的損害を生じさせるようなその他の使用 (以下「本目的外使用」という。) のためには設計, 意図又は承認されていない。重要な構成部分とは, それの不具合が装置若しくはシステム

の不具合を生じさせるか又はその安全性若しくは実効性に影響すると合理的に予想できるような装置若しくはシステムのあらゆる構成部分をいう。Cypress 製品のあらゆる本目的外使用

から生じ, 若しくは本目的外使用に関連するいかなる請求, 損害又はその他の責任についても, Cypressはその全部又は一部をとわず一切の責任を負わず, かつ Cypressはそれら一切

から本書により免除される。Cypress は Cypress 製品の本目的外使用から生じ又は本目的外使用に関連するあらゆる請求, 費用, 損害及びその他の責任 (人身傷害又は死亡に基づく

請求を含む) から免責補償される。 

Cypress, Cypress のロゴ, Spansion, Spansion のロゴ及びこれらの組み合わせ, WICED, PSoC, CapSense, EZ-USB, F-RAM, 及び Traveo は, 米国及びその他の国における

Cypressの商標又は登録商標である。Cypressのより完全な商標のリストは, cypress.comを参照すること。その他の名称及びブランドは, それぞれの権利者の財産として権利主張がな

されている可能性がある。 

 

http://www.cypress.com/
http://www.cypress.com/?id=1062
http://www.cypress.com/products
http://www.cypress.com/products/32-bit-arm-cortex-mcus
http://www.cypress.com/applications/automotive-solutions
http://www.cypress.com/products/clocks-buffers
http://www.cypress.com/products/interface
http://www.cypress.com/internet-things-iot
http://www.cypress.com/products/memory-products
http://www.cypress.com/mcu
http://www.cypress.com/psoc/
http://www.cypress.com/products/power-management
http://www.cypress.com/products/touch-sensing
http://www.cypress.com/products/usb-controllers
http://www.cypress.com/products/wireless-connectivity
http://www.cypress.com/psoc
http://www.cypress.com/products/psoc-1
http://www.cypress.com/products/psoc-3
http://www.cypress.com/products/psoc-4
http://www.cypress.com/products/32-bit-arm-cortex-m3-psoc-5lp
http://cypress.com/psoc6
http://www.cypress.com/cdc
https://community.cypress.com/welcome
http://www.cypress.com/cypressgithub
http://www.cypress.com/projects
http://www.cypress.com/video-library
http://www.cypress.com/blog
http://www.cypress.com/training
http://www.cypress.com/cdc/community-components
http://www.cypress.com/support
http://www.cypress.com/support

	1 はじめに
	2 PSoCリソース
	2.1 PSoC Creator
	2.3 PSoC Creatorヘルプ
	2.4 テクニカル サポート

	3  PSoC 4のセグメントLCD駆動の特長
	4 セグメントLCDの基本
	5 PSoC Creatorコンポーネント: セグメントLCD
	6 PSoC 4 セグメントLCDの直接駆動
	6.1 PWM駆動モード
	6.2 デジタル相関駆動モード
	6.3 低消費電力動作

	7 PSoC 4ユーザー インターフェース ソリューション
	8 PSoC Creatorプロジェクト
	8.1 プロジェクト1: セグメントLCDの基本
	8.2 プロジェクト2: 低消費電力セグメントLCD
	8.3 プロジェクト3: セグメントLCDおよびCapSenseユーザー インターフェース
	8.4 プロジェクト 4: キャラクタ型セグメントLCD

	9 まとめ
	改訂履歴
	ワールドワイドな販売と設計サポート
	製品
	PSoC®ソリューション
	サイプレス開発者コミュニティ
	テクニカル サポート


